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Introduction 
 
Molecules are groups of atoms, joined by chemical bonds, forming different types of geometry in 
space. This structure provides information on the function and properties of each molecule. The 
observation of molecules can therefore be used to understand, illustrate and educate about biological 
processes, and is known as molecular visualization. 
 
Molecular visualization has always been important to chemists in structural molecular biology. Over 
time, modeling methods have always kept pace with technological advances. The original physical 
models made of paper or brass were replaced by the arrival of computers, and then enhanced by 
advances in video games. These advances have made it possible to analyze more molecules, of larger 
size and greater complexity. 
 
This discipline presents a number of challenges, such as deciding on the representation of the molecule 
and its influence on the target audience. Indeed, any image depends on what you're trying to 
demonstrate about the molecule, and needs to be presented in such a way as to bring understanding to 
the chosen subject.  
 
The aim of this tutorial is to introduce new users to VTX software and molecular visualization. It is 
therefore organized in such a way that a theoretical part is followed each time by a small exercise in 
gray backgrounds with a light bulb. The aim is to visualize the interaction zone between a ligand and a 
polymer. 
 
This tutorial was written using VTX v0.4.0. 
 
 

Download 
 
VTX is freely available on Windows and Linux on : https://vtx.drugdesign.fr 

Before downloading the software, you'll find a link to a readme: (https://gitlab.com/VTX_mol/VTX/-

/blob/master/README.md) with installation conditions, as well as some shortcuts and commands we'll 

be coming back to in this tutorial. But also commands for the interface & for future improvements. 

 

Opening the software 
 
On Windows, you can open the software in the “VTX_0.4.0” folder in the downloads by double-clicking 
on it. 
On Linux, you can open the software, located in the Bin folder, using the terminal, for example, with the 
command “./VTX”. 

UI 
 
First of all, when you open the application, you're presented with various panels. 
 

https://vtx.drugdesign.fr/
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- the scene: lists and controls all the elements displayed in the 
display panel  
- the inspector: provides additional information on what is being observed 
- the sequence: displays the primary sequence of proteins in one-letter code 
- the console: displays information such as what has been done. 
Each of these panels can be separated to form a new window or moved to another location. To do this, 
click and hold on the panel while moving it to the desired location. 
 
We also see a menu interface with different tabs, each linking to different tools, which we'll describe in 
turn. In this tutorial, we'll refer to each menu by locating it according to its tab, its part and its name, such 
as : 

  
 
 
There are also overlays on the display panel with shortcuts to various options. These overlays can be 
removed by right-clicking, then clicking on overlays and selecting either Show all to show them all or 
Hide all to hide them all, then checking or unchecking Controller & Rendering. 
 
 
 

Opening a molecule file 
 



 3 

To be able to visualize molecules on a computer, we first need to determine their structures. Several 
techniques are available, depending on the size and crystallization capacity of the molecule under study: 
- NMR spectroscopy is used for small molecules. 
- X-ray crystallography for proteins that can crystallize. Indeed, some proteins are very difficult to 
crystallize, notably those that are highly disordered or unstable, or those that are insoluble in water. This 
technique is the most widely used. 
- Cryo-electron microscopy, a rarer technique used for large molecules. 
 
Once these structures have been obtained, they are formatted into a short text document, and submitted 
to the Research Collaboratory for Structural Bioinformatics (RCSB), the organization in charge of the 
Protein Data Bank (PDB) on which the results will be published.  
The PDB is a U.S.-based, open-access digital database that serves as a global archive of data, such as the 
3D structure, of proteins. 
 
 
 In the PDB, files are identified by a 4-character code. 

 
 
Returning to VTX, we want to open a molecule in order to visualize it. There are two ways of doing this: 
 

• You can choose to go to the Files tab, then select download in the session section. This will open 
another page where you can enter the 4-character PDB code and press open. 

•  

• Alternatively, you can first download the short text corresponding to the molecule's structural 
data from the PDB website. To do this, search for the molecule under study, then select PDB 

         

For example, 4HHB corresponds to human hemoglobin. This protein transports oxygen 
from the lungs to the rest of the body. It is made up of 4 identical polypeptide chains, each 
linked to a heme. On the PDB website, you can see that it was obtained by crystallography. 
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Format in the download files menu. The file will then appear in your computer's downloads and 
will be named after the PDB's 4-character code. You can then return to VTX, in the Files tab, and 
select Open in the session section. You will then need to select the file downloaded from PDB. 

 
 

 

 
 
Whichever method you choose, the molecule appears on the visualization panel. 
 
In the scene, a line appears with the code of the molecule, and by clicking on the small triangle before 
the name, you can see the different chains forming the molecule. 

         

Try one of these methods with 4HHB. After that, this is what your window should 
look like: 
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These are divided into main polymer chains, ligands, ions and waters. By clicking on the corresponding 
triangles, you can then see the different chains, then the amino acid residues at the origin of the protein, 
and finally the atoms. 
 
The sequence shows the same succession of amino acids for each chain, differentiated by color. 
Water molecules can be seen around each chain. These molecules may be water of crystallization, the 
result of experimentation to obtain the protein structure. In fact, when obtaining the structure of the 
molecules, it is possible to add not only water, but also solvents or ions that would still be on the PDB 
file. 
On VTX, these can be easily removed by going to the Edit tab and clicking on Waters, or Solvent, or Ions 
in the Element Visibility section. Depending on the method used to obtain them, hydrogens may be 
displayed to clarify the space observed; they can also be removed in the Edit tab, by clicking on 
Hydrogens in the same section. 
 
In the Visualization tab, in the projection section, you can click on either orthographic or perspective.  
In the orthographic option, the molecule is represented in its true dimensions, like a drawing on a 2D 
plane. In the perspective option, the distances between the atoms are manipulated so that we see the 
molecule as we would in real life, i.e. the parts closest to us take up more space, while those farthest from 
us are smaller, giving us an impression of depth and therefore of 3D. 
 
 
 

 
 
This option is also available by right-clicking in the viewer panel, then clicking on projection in the 
render section and selecting perspective or orthographic. 

  

Orthographic 

Perspective 
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Mouse movements 
 
Several types of movement are possible around the molecule, each of which can be activated with the 
mouse or on the interface in the Visualization tab of the navigation section. However, it is recommended 
to use a mouse to manipulate the molecule more comfortably. At any time, you can return to the starting 
point by clicking on reset in the Visualization tab in the navigation section, or save your position to return 
to it more easily later in the same tab in the Viewpoint section by clicking on create. 
 
This action will add a line in the scene called Viewpoint 1, which double-clicking on will take you back 
to this viewpoint. You can also rename it by right-clicking on it and then clicking Rename in the sub-
menu that appears. 
 

 

         

For 4HHB observation, you can try unrolling the scene menus. You'll get a scene 
like : 
 

With Element Visibility, you can remove ions from vision. If you hide the hydrogens 
and the solvent, there's no difference. On the other hand, in this tutorial we'll be using 
waters, so leave Waters in green! 
 

We're going to manipulate the molecule, so it's best to stay in perspective mode. 
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To move around the molecule (regardless of the type of movement), click and drag on one side. 
On a 3-button mouse, you can use: 

• The left button, which works as a trackball: This mode allows you to move the camera 
around the molecule as follows 

 
• The middle button that works in Freecam: This mode moves the camera angle while 

looking at the molecule from a fixed point. Such as: 

 
• The right button works to turn the camera on the spot, such as : 

 
 
You can also reduce or increase your field of vision using the thumbwheel. By rolling it forwards, you 
zoom in on the area you're looking at, thus reducing the field of view. This is known as slabbing. 
Conversely, rolling the wheel backwards will zoom out, increasing the field of view. This process is 
called clipping. 
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Selection Modes 
 
By left-clicking on the molecule, we can see that it is highlighted with a green layer, which shows us 
that we have selected it entirely. To deselect, you can click anywhere else. 
 

         

Move around the molecule to identify at least one interaction between one of the ligands 
and its corresponding monomer. Then record the point of view from which you are 
standing. For example, if you choose to observe the blue monomer, you get : 
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 It is also possible to select part of a molecule. By right-clicking anywhere on the display page, a menu 
appears, allowing you to click on Target selection, then another submenu appears, offering selection at 
molecule, chain, residue or atom level. 
 

 
 
You can also use the Controller overlay by clicking on the logo circled in red and then choosing from 
the submenu what you want to select, such as : 

 
 
Once the desired selection has been made, it can be seen more clearly by moving the mouse or clicking 
on orient in the Visualization tab in the Navigation section. In addition, the selected part will be 
highlighted in the scene in lighter grey, making it easier to identify. 
 
You can also select at different scales by double-clicking directly on what you want to see in the scene. 
To select a residue, you can also use the sequence. By double-clicking on a residue in the sequence, it 
will be selected in the visualization page. Conversely, if a residue is selected, it will be highlighted in the 
sequence. 
In these two other cases, the orient function is performed automatically. 
 
Following any selection, the inspector will display related information in different sub-sections: 

➢ Representation: which we will describe in detail in the section “Actions on the molecule: repre-
sentations & colors”. 

➢ Info: lists different information depending on the scale. The information available is summa-
rized in the table below: 

 
Scale of the selection 

 
Informations disponibles 

System 
- name 
- chain number 
- atom and chain 
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Chain 
- molecule number 
- atom and residue number 

Residue 
- residue name 
- atom name 
- covalent bond list 

Atom 
- name 
- full name 
- covalent bond 

 

➢ Position: Only available for atoms, gives the X, Y, Z coordinates of the selection 

➢ Transform: Only available for molecules, allows you to move the molecule or change its scale 
according to the X, Y, Z axes. 

➢ Autorotation: automatically rotates the molecule according to the X, Y, Z axes. 
 
 

 

 

Molecule actions: show, hide, delete 
 

It is possible to simplify the view. If the molecule is made up of parts which are not useful for what we're 
trying to visualize (for example, several identical chains), we can choose to delete them by selecting them 
and then clicking on delete in the molecule action section of the Edit tab, or by right-clicking on the 
corresponding line in the scene and then clicking on delete in the sub-menu. 
If you don't want to see this part of the molecule without deleting it, you can hide it by clicking on Hide 
in the Molecule action section of the Edit tab. 
If you only wish to observe a part of the molecule (at any scale), you can select it and then click on Solo 
in the Molecule action section, which will hide the rest of the molecule. To show what's been hidden, 
simply click on Show, and if you've lost your selection, right-click in the viewing panel and select Show 
All. 
 

         

After moving around the molecule, try selecting the polymer's B chain. You should 
see a screen like this: 
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The scene can also be used to show or hide molecules, or parts of molecules. Each line of the scene is 
preceded by a checkbox which can be checked or unchecked, displaying or hiding the selection. 
 
To manipulate a part of the molecule more simply, it is possible to select it and then click on Extract, 
which will separate it into another line of the scene where the extract will be named: “Extract of” followed 
by the code of the open protein.  By right-clicking on this line and selecting Rename from the submenu, 
you can rename the extract. 
 

 

 

Molecule actions: Representations and colors 
 

 
There are different ways of representing molecules, each with its own specific features: 
 

 
Representation 

 
Characteristics 

 
Example 

         

The 4HHB molecule contains 4 monomers linked to their respective ligands. We will 
keep only the A group. Try deleting or hiding parts of the molecule so as to leave 
only the A monomer, the A ligand and the A water molecules. Then, if you hadn't 
chosen this chain and ligand, create a new viewpoint as you did when applying the 
“Mouse movements” section.  
You should obtain a viewpoint similar to : 

(Here we've chosen to remove unnecessary parts to simplify the view. If you have 
decided to hide unused parts, these parts will still appear in the scene, but just not 
checked). 
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Ball & stick 

Gives details of atomic resolution structures. But 
it's difficult to distinguish the different protein 

chains. 

 

 
Cartoon 

Highlights aspects of secondary and tertiary 
structure at the protein backbone level, but makes 
it difficult to obtain information on the chemistry 

of the molecule, or to visualize its volume. 

 

 
Cartoon + stick 

Highlight secondary and tertiary structures while 
displaying the atoms at the ends as sticks. 

 

 
Stick 

Gives details of atomic resolution structures in 
CPK color (blue: nitrogen, red: oxygen...) but 

clutters the view of large molecules. 

 

 
Solvent Excluded 

Surface (SES) 

Provides information on the molecule's overall 
shape, complexity and assembly. However, this 

representation prevents us from seeing the inside 
of the protein. 

 

 
Solvent 

Accessible 
Surface (SAS) 

Provides information on the molecule's overall 
shape, complexity and assembly. However, this 

representation prevents us from seeing the inside 
of the protein. 

 



 13 

 
Van Der Walls 

(VDW) 

Provides information on the molecule's overall 
shape and assembly, as well as its steric hindrance. 

In this representation, the VDW surface of each 
atom appears as a sphere. However, this 

representation prevents us from seeing the inside 
of the protein. 

 

 
It is possible to change the representation of the molecule or part of it. To do this, select the desired part 
of the molecule, then use one of 2 methods: 

• The easiest way is to click on the desired representation in the Edit tab (Ball and Stick, 
Cartoon, Cartoon + Stick, SAS, SES, Stick or VDW). 

 

• The second method offers greater differentiation possibilities. Once the selection has been 
made, in the inspector it is possible to go to representation, then change the type of 
representation, then the various characteristics inherent in this representation. This method 
also allows you to change the color of the selection. Depending on the representation of the 
selection, you can : 

 

Representation Options UI 

 
Ball & stick 

- change the radius of the spheres and rods of 
a whole chain or of certain residues to 

differentiate them. 
- change the coloring mode, i.e. color the 

entire molecule, chain or residue in a single 
color. Or color 

 

 
Cartoon 

- change the coloring mode to color according 
to tertiary structure (Jmol), color the entire 
selection with the same color (Molecule, 

Chain, Custom), color according to residue 
type (Residue) 
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Stick - change stick thickness 

- change the staining mode to stain the entire 
selection while maintaining CPK staining 
(Atom-Chain, Atom-custom, Atom-objet), 
stain according to residue type (Residue), 

stain the entire selection with a single color 
(Chain, Molecule) 

 

 
Cartoon + stick 

- combines the possibilities of cartoons & 
sticks 

 

 
Solvent Excluded 

Surface (SES) 
- change the coloring mode to color the entire 

selection while retaining CPK coloring 
(Atom-Chain, Atom-custom, Atom-objet), 
color according to residue type (Residue), 
color the entire selection in a single color 

(Chain, Molecule). As for sticks. 

 

 
Solvent Accessible 

Surface (SAS) 

- change the color mode with the same 
options as for sticks & SES. 

 

 
Van Der Walls 

(VDW) 

- change the color mode with the same 
options. 
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In the Edit tab, in the representation section, there is also a Preset Settings option. This allows you to 
create a shortcut to a representation type whose shading, SSAO intensity (for spatial orientation), 
blurring, border and more can be customized. 
This new representation can then be selected in the same way as the first method. 
 
 

 
 

Molecule actions: Measures and Analysis 
 
In the Tools tab of the interface, the distance button allows you to measure the distance between 2 atoms. 
To do this, simply click in turn on the 2 atoms that delimit the distance you wish to measure. This can be 
useful, for example, to determine whether a weak bond can be formed between 2 atoms. Once drawn, 
each distance appears in the scene, and can be shown or hidden by checking or unchecking, and renamed 
by right-clicking. The distance also appears in the inspector, where you can change its color. 
 

         

Try increasing the thickness of the sticks representing ligand A to 0.3 radius. Also 
change its color from the inspector with Atom-Custom to better distinguish it. 
Then go to Viewpoint 1 (created earlier in the mouse movement section) by 
double-clicking on it. 
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 The same applies to angles & dihedral angles available at the same location. 
All these options are available by right-clicking in the viewer panel, then clicking on measurement in 
mouse mode and selecting Distance, Angle or Dihedral angle. 
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In human hemoglobin, the heme is composed of an Fe2+ cation (shown in 
orange according to CPK codes) which forms a covalent bond with the F8 
residue of globin located below its plane. Try selecting this residue, and 
changing its color with inspector atom-object. Such as:  

The Iron cation can also bond with a water molecule above its plane. Try 
thickening this molecule so that you can see it better, such as : 

The average distance between the donor & acceptor of a hydrogen bond is around 
2.7 & 3.3 Angstroms. Try using the measurement tool to find a hydrogen bond 
made by the water molecule you've just thickened. You should find the same as 
in the following screenshot (NB: to make it easier to see in this screenshot, some 
residues have been hidden and will be re-displayed afterwards). 
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You can then change the color of the residue to match that of residue F8.  
Continue to look for interactions between heme and globin using the same method. All the interactions 
are shown below: 

You can take advantage of this moment to find and create better viewpoints, so that the interaction zone 
is clearly visible. In addition, to better distinguish this zone, change the rest of the molecule into a 
cartoon (by selecting the chain and then using the interface). 
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Background Color 
 
In the Background section of the Visualization tab, you can choose between a white or black background. 
While a black background is often more pleasing on the screen, a white background is preferred for 
publications, as it is the same color as the paper and therefore provides better contrast and facilitates 
printing.  
It is also possible to change this option by right-clicking in the visualization panel, then clicking on 
background color in Render and selecting black or white.   
 
 There's also a render effects section in the visualization tab, where you'll find 2 options, Default and 
Sketch, which allow you to modify the molecule drawing in the visualization panel. There's also the 
preset settings option, which lets you create new drawings while adjusting shading, SSAO, surround, 
fog, background and light color. These options are also available by right-clicking in the visualization 
panel, then in the render section, in Apply render settings, you can choose between Default, Sketch and 
Settings. 
 
 

 
 

Snapshot 
 
To share your work, you can take a screenshot of the visualization panel with the resulting molecule. To 
do this, simply click on Snapshot in the Visualization tab. Alternatively, right-click on the image and 
click on Snapshot. This capture can be found in the Snapshot folder in the VTX folder, and is 
automatically named with the date and time of capture. 
 
In some cases, such as posters with colored backgrounds, you may also want a molecule on a 
transparent background. This is possible by going to the settings in the Windows section. In the 
Graphic sub-section, simply set snapshot format to pgn and snapshot background opacity to 0.  

         

Try changing the background to white. 
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Workspace saving 
 
At any time, you can save your progress by clicking on Save as in the session section of the file tab and 
then simply clicking on Save. This saves the VTX file (.vtx) with all the modifications made. It can then 
be reopened at any time by opening the software and clicking on open in the File tab of the session 
section. 
It's important to save your progress as you go along, as there's no way to go back after a mistake, so this 
allows you to go back without starting from scratch. 

Conclusion 
 
 
Congratulations on finishing this tutorial, in which we've learned the basics of VTX. We've also seen 
how to observe a zone of interaction between a ligand and a protein. 
 
There are other features available that you can try out, such as trajectory alignment.  
 
VTX is a very recent software, and as updates are made, new capabilities will be added, enabling it to 
compete with more implemented software such as Pymol or Chimera. 

         

Try taking a screenshot. 
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